
WinUnzip Help Contents
WinUnzip version 4.0
Welcome to Help for WinUnzip.    WinUnzip is a utility program that is used to extract and/or view the 
contents of ZIP files and self extracting EXE files created PKZIP or 100% compatible programs.

For more information on how to use the Windows help feature press F1.

Select one of the topics below for further information about WinUnzip.

Commands
Menu
Keyboard
Toolbar
Command Line Switches

More Information
Main View
License / Registration / Support
Glossary
Installing
Uninstalling

How To...
Open a ZIP file
View a member file
Extract member files
Select member files
Use the Drag & Drop feature



Main Menu
This is the main menu for WinUnzip.    All program commands are available within these four 
submenus.

File
Open
Close
Extract
Try It
View
Exit

View
Sort By Name
Sort By Extension
Sort By Date & Time
Sort By Size
Sort By Path

Options
Set Options

Help
Index
Brings up this help file displaying the main WinUnzip help index.

About...
Displays the WinUnzip "about" box showing author, version number, Windows version and system 
resources.



Open command
Displays the "open file" dialog box. This allows you to select a ZIP file to work with. The file is 
selected by double clicking with the mouse on the desired file or by tabbing to the list box then 
selecting the desired file and pressing [Enter].

Shortcut keys
Ctrl + O

Toolbar button



Close command
Closes the current ZIP file, clears the main member file list box, resets the program title bar, and 
releases computer resources used when a ZIP file is opens

Shortcut keys
Ctrl + C



Extract command
Extracts, or unzips, member files from the current ZIP file. This command is selected by choosing 
Extract from the File menu, by using the keyboard command Ctrl+E, or by clicking the appropriate 
toolbar button.

Selecting the Extract command will display the Destination Dir dialog box. This is where you select 
the destination directory for the member files that will be extracted. If you have selected the Recreate
Dir checkbox in the Options dialog box and there are directories stored in the ZIP file then files will be
placed in their associated directory, if any, below the destination directory.

Shortcut keys
Ctrl + E

Toolbar button

Note:
You may stop the extracting process by pressing the Esc key.    When you do so a dialog box will be 
displayed which will allow you to continue extracting or stop.

See also
Destination dialog box
Overwrite dialog box
Drag & Drop operation
Selecting member files
Setting Options



Destination dialog box
This is a picture of the Destination Dir dialog box.    You may get further information about various 
parts of the dialog box by moving the mouse cursor to the desired location.    If the cursor changes to 
a finger-pointing hand then you may click that area and a window will pop up with information about 
that area.



Overwrite & Rename dialog boxes
If the Overwrite check box has NOT been checked in the Set Options dialog box then WinUnzip will 
display the dialog box below if it finds a file in the destination directory with the same name as the 
one being extracted.

As you can see you have several options:
n Clicking the Yes button will overwrite the existing file.
n The No button prevents an overwrite and skips this member file in the extraction process.
n Clicking All will overwrite all or any files in the destination directory that have the same name as 

the one being extracted.
n Pressing Cancel stops the extraction process.
n Clicking the Help button will display this help file.

Clicking on the Rename button above will display the Rename File dialog box below. Here you may 
give the member file that is being extracted a different name when it is extracted to the destination 
directory.



Drag and Drop
This is a feature of Windows and some Windows programs that allows you to click the left mouse 
button on an object, drag it (move the object while keeping the left mouse button depressed), then 
dropping it (releasing the mouse button) on a target program.

If an object can be dragged the mouse cursor will change from a pointer to another shape 
(depending on the program).    When the dragged object is over a program that accepts dropped 
items then the mouse cursor will change to acknowledge this, usually including the plus '+' sign.

WinUnzip allows files to be dropped on it from the File Manager and allows ZIP member files to be 
dragged from the WinUnzip display to some target object, presumably a file viewer.

Dropping on WinUnzip
To use drag and drop to open a file in WinUnzip simply drag the file from File Manager and drop it on
WinUnzip.    This works whether WinUnzip is in a normal or icon state.    If WinUnzip is minimized it 
will pop open to show you the ZIP contents. 
You may also drop a ZIP file on WinUnzip while it is in a desktop icon such as Norton Desktop for 
Windows or PC Tools for Windows.

Dragging from WinUnzip
Click on a member file while it is displayed in WinUnzip and drag it to a target program.    If allowed to
drop on the target WinUnzip will display the Destination Directory dialog box, unzip the member file 
to the desired directory, then feed the file to the target program!



Selecting Member Files
Member files may be selected using normal Windows listbox selection methods. Consult your 
Windows manual for a complete discussion.

Selecting Single Files
Tab to the contents listbox and press the space bar to highlight or select a file.
-OR-
Click the left mouse button on the desired file.

Selecting Multiple Adjacent Files
Click on the first member file.
While holding down the [SHIFT] key click on the last desired member file.
-OR-
Click the right mouse button on each desired member file.

Selecting Multiple Non-Adjacent Files
Click on the first member file.
While holding down the [CTRL] key click on the next desired file.
-OR-
Click the right mouse button on each desired file.



Set Options command
This dialog box allows you to set the target directory as well as various defaults values used by 
WinUnzip.

Shortcut keys
Ctrl + S

Toolbar button

Destination Dir
This is the subdirectory where you want the member files to be extracted. The program defaults to 
the directory where WinUnzip was called from unless the Save Destination check box is checked. In 
the latter case the last directory used will be displayed in this edit field.

Working Dir
This directory is used to temprarily extract files to when using the View or Try It commands.    
WinUnzip uses this directory as a base directory and appends \V$U$E$ or \T$RY$ to it for safety 
reasons. It then temporarily extracts the file to be viewed to this directory. After the file has been 
viewed WinUnzip deletes the file and the newly created temporary directory. 

The Working directory is useful when viewing member files of a ZIP file that is on a disk that has little
or no free space left. For example, if    you opened a ZIP file on A:, instead of trying to extract    a 
member file to A: where there may be no disk space left, WinUnzip will use the Working directory, for 
example C:\TEMP\V$U$E$, to extract and view the file from. 

WinUnzip will default to the directory you have specified as your Windows TEMP directory the first 
time you run the program. If the directory you specify does not exist WinUnzip will offer to make it for 
you.

Default Viewer
The viewer can be any program that will display a file and accepts a file name on the command line. 
WinUnzip defaults to NOTEPAD.EXE.    When viewing a file WinUnzip first calls the program 
associated with the file extension of the member file you want to view. If no association exists, then 
WinUnzip will attempt to use the program you designate here as the viewer.

TIP: If you have a file viewer, such as Central Point's File Viewer, that displays files in native format 
we suggest you use that as your default viewer.

Overwrite Files
If this box is checked then WinUnzip will automatically over write existing files of the same name as 
that being extracted. If this box is unchecked then a message box will display giving you the option to
over write the file.

Recreate    Directories
By checking this box WinUnzip will use any directories that were stored in the ZIP file. It does this by 
creating the appropriate directory beneath the specified destination directory. Stored directories will 
always display, if present, to the right of the member file list box.

Save Destination Directory
By checking this box WinUnzip will use the directory specified in Destination Dir (above) as the 
destination or target directory each time the program is run instead of the current directory.    Please 
note that a destination directory specified on the command line will over ride this setting.



Beep On Completion
A check box that, when checked, allows a beep tone to signal the end of an extract operation.

Dest Dir (button)
Displays the Destination Dir dialog box so that you may select the directory to which you want to 
extract files by clicking and scrolling through your current list of directories.

See also
Set Options dialog box



Options Dialog Box
This is a picture of the Options dialog box.    You may get further information about various parts of 
the dialog box by moving the mouse cursor to the desired location.    If the cursor changes to a finger-
pointing hand then you may click that area and a window will pop up with information about that area.



Try It command
This command provides a convenient way to try out the contents of the ZIP file.    Try It extracts all 
the member files to a temporary directory then builds a Program Manager folder in which it displays 
each member file as a separate icon.

When you close the ZIP file the Try It folder is deleted from Program Manager and the files are 
deleted from the temporary directory.

Shortcut keys
Ctrl + T

Toolbar button



View File command
This command will allow you to view the contents of a member file.    The program used to view the 
file is the one associated with this type of file or file extension in your WIN.INI file, section 
[EXTENSIONS].    If no association is found there the registration data base is checked.    In other 
words, if you "view" a file with the "wri" extension, then the word processor Write would be 
automatically used to view this member file.    If no association can be found for the member file to be
viewed then the program designated in the Viewer field of the Options dialog box will be used.    
While viewing a file WinUnzip will minimize itself to an icon. When you exit the viewer program 
WinUnzip will return to normal size.

This command may be selected from the menu, by pressing the shortcut key Crtl + V, by pressing 
[Enter] while the member file is highlighted, or by double clicking the left mouse button on the file in 
the main display.

Shortcut key
Ctrl + V

Mouse action
Double click on the member file that you wish to view.

See also
Drag & Drop operations



Exit command
This command will exit WinUnzip normally, closing any ZIP files that might be open and removing the
Try It folder from Program Manager if it still exists.

Shortcut keys
Alt + F4

Mouse action
Double click on the system menu in the upper left corner of the program window.



Sort By Name
Displays the ZIP file contents sorted alphabetically by member file names. 

Selected from the View menu or by clicking the left mouse button on "Name" in the header display 
located just above the contents display window.



Sort By Extension
Displays the ZIP file contents sorted alphabetically by member file name extensions. 

Selected from the View menu or by clicking the left mouse button on ".ext" in the header display 
located just above the contents display window.



Sort By Date And Time
Displays the ZIP file contents sorted alphabetically by member file date & time stamps. 

Selected from the View menu or by clicking the left mouse button on "Date" or "Time" in the header 
display located just above the contents display window.



Sort By Size
Displays the ZIP file contents sorted numerically by member file sizes. 

Selected from the View menu or by clicking the left mouse button on "Size" in the header display 
located just above the contents display window.



Sort By Path
Displays the ZIP file contents sorted alphabetically by member file path names, if any.

Selected from the View menu or by clicking the left mouse button on "Path" in the header display 
located just above the contents display window.



Keyboard Commands
You may execute most menu commands in WinUnzip using either the keyboard or a mouse.    For 
some WinUnzip's short cut keys may be faster than using the menu or toolbar buttons.

Ctrl + O
Displays the open file dialog box from which you may open a ZIP file.

Ctrl + E
Extracts member files.

Ctrl + T
Try It!    Extracts member files to a temporary directory then creates a program group folder in 
Program Manager so you can easily try out the files to determine their value to you.

Ctrl + V
View a member file. You may also view a file by double-clicking on it.

Ctrl + C
Close the ZIP file but leave WinUnzip running.

Ctrl + S
Displays the Set Options dialog box where you can set or change various WinUnzip program 
settings.

Esc
Pressing the Esc key while a member file is being unzipped will display a dialog box allowing you to 
stop unzipping or to continue.

See also
Command Line Switches
Toolbar Controls



Command Line Switches
Command line switches are very useful when calling WinUnzip from within Windows shell programs 
or batch languages.    Command line switches cause WinUnzip to perform different actions or behave
differently when the program is first started.

WinUnzip [-x] [filename] [memberfile] [destination]

-x is one of the command switches below:
                -X Extract all files then quit.
                -E Extract the specified member file.
                -Q Run quietly, or as an icon. Do not open the program window.
                -D Use the stored directories when extracting.
n "filename" is the name of the ZIP file.
n "memberfile" is the name of the member file within the ZIP file to be extracted.
n "destination" dir is the directory to which you want the member file extracted. The default is the 

current working directory.



Toolbar Controls
Buttons
The Toolbar places the most used commands in graphical buttons just below the menu bar. These 
buttons include Open, Extract, Try It, and Set Options and correspond to the equivilent keyboard or 
menu commands.

Commands called from the toolbar buttons operate the same as if selected from the menu or with a 
short cut key. The toolbar buttons can only be accessed with a mouse.

Progress Gauge
The toolbar also contains a gauge to graphically show you the progress while extracting a member 
file.    As each member file is extracted its name will appear in the gauge as the progress bar    moves
behind it.

See also:
Main View
Command Line Switches
Keyboard Commands



Main View
This is a picture of WinUnzip as it looks displaying the contents of a ZIP file.    You may get further 
information about various parts of WinUnzip by moving the mouse cursor to the desired location.    If 
the cursor changes to a finger-pointing hand then you may click that area and a window will pop up 
with information about that area.

See also
Options dialog box
Destination Dir dialog box
Overwrite & Rename dialog boxes



License
Please be sure that you understand the terms of the license agreement. Use of WinUnzip beyond the
30 day evaluation period constitutes acceptance of the terms of the license agreement and requires 
registration.

Agreement
You may use the unregistered version of    WinUnzip for a 30 day evaluation period. You may at any 
time redistribute the complete WinUnzip software package without charge. Use of WinUnzip after the
30 day evaluation period requires payment of the registration fee and without such constitutes 
violation of the federal copyright laws.

Registration
You may register WinUnzip for single computer use at $15 per copy.    Use of WinUnzip on a network 
requires a network registration fee of $150 per 20 work stations. Upon registration a unique ID will be
supplied that removes the opening registration screen. You may mail registration fees in the form of 
checks (drawn on a U.S. bank) or money orders to:

        Mickey Coulter
        2204 Edinburgh Drive
        Montgomery, AL 36116

You may also register WinUnzip on CompuServe. The registration fee will be added to your 
CompuServe bill. At the ! prompt type:

        GO SWREG and search for ID 1465

Thank you for registering!

Upgrades
If you are a registered user of WinUnzip 3.x you may upgrade to version 4.0 for $7.00.    Upgrades 
will only be handled by mail.    Please include your old registration ID and current address.

Disclaimer
WinUnzip and accompanied files are sold "as is". The user assumes all responsibility for its use. 
Liability on the part of the seller is limited to registration fee refund if requested.

Support
For registered users the first stop for questions and support is CompuServe.    

Send CIS e-mail to:
      76317,242

By U.S. mail:
      Mickey Coulter
      2204 Edinburgh Drive
      Montgomery, AL 36116

By phone:
      (205) 279-8498



Glossary
A
association

C
current directory

M
member files

S
short cut keys

T
TEMP

W
WinUnzip

Z
ZIP



Installation
1 Make a subdirectory where you would like to keep WinUnzip.
2 Copy WINUNZIP.EXE and WINUNZIP.HLP to that directory.
3 Copy CTL3D.DLL to any directory that is on your system path.    This is usually c:\windows\

system.

Associating ZIP files
It is recommended that you associate ZIP files with WinUnzip.    

To do so...
1 Open File Manager.
2 Highlight a ZIP file.
3 Select the Associate command from the File menu.
4 Type the full path and file name for WINUNZIP.EXE or use the browse command.
Now, when you double click on ZIP files from File Manager WinUnzip will run displaying the contents 
of the Zip file.



Uninstalling
1 From the directory to which you copied WinUnzip delete    the files WINUNZIP.EXE and 

WINUNZIP.HLP.
2 From your main Windows directory (usually c:\windows) delete WINUNZIP.INI.
3 Delete CTL3D.DLL from the directory to which you copied it.    This is usually the Windows 

system directory (c:\windows\system).
NOTE! If you have Microsoft Excel or other programs that use CTL3D.DLL SKIP STEP 3!



You may change the current drive by clicking the down button on this combo box then clicking on the 
desired drive.



Type the name of the desired destination directory in this edit field or select from the directory tree 
below.



These radio buttons allow you to change your mind about extracting files.    If you have selected any 
files in WinUnzip then the Selected button will be pushed.    You may change your mind and push All 
to extract all files to the destination directory.    Note, if no files were seleted in WinUnzip then the 
Selected button will be grayed out or disabled and the All button will be pushed.



This is a list of directories available on your current disk drive.    You can see more directories, if 
available, by using the scroll bars. Select a directory by double clicking the left mouse button on the 
directory.



Extract button
Extracts member files from the current ZIP file. Selecting the Extract command will display the 
Destination Dir dialog box.    This is where you select the destination directory for the member files 
that will be extracted. If you have selected the Recreate Dir checkbox in the Options dialog box and 
there are directories stored in the ZIP file then files will be placed in their associated directory, if any, 
below the destination directory.

Shortcut keys
Ctrl + E



A progress gauge that graphically displays the relative progress in extracting a member file.    It also 
shows the name of the file being extracted.



Open button
Displays the "open file" dialog box. This allows you to select a ZIP file to work with. The file is 
selected by double clicking with the mouse on the desired file or by tabbing to the list box then 
selecting the desired file and pressing [Enter].

Shortcut keys
Ctrl + O



Try It button
Provides a convenient way to try out the contents of a ZIP file.    Try It extracts all the member files to 
a temporary directory then builds a Program Manager folder in which it displays each member file as 
a separate icon.

When you close the ZIP file the Try It folder is deleted from Program Manager and the files are 
deleted from the temporary directory.

Shortcut keys
Ctrl + T



A check box that, when checked, allows a beep tone to signal the end of an extract operation.



Radio buttons used to select upper case or lower case display of the member files in WinUnzip's 
main window.



This is the subdirectory where you want the member files to be extracted. The program defaults to 
the directory where WinUnzip was called from unless the Save Destination check box is checked. In 
the latter case the last directory used will be displayed in this edit field.



Displays the Destination Dir dialog box so that you may select the directory to which you want to 
extract files by clicking and scrolling through your current list of directories.



If this box is checked then WinUnzip will automatically over write existing files of the same name as 
that being extracted. If this box is unchecked then a message box will display giving you the option to
over write the file.



By checking this box WinUnzip will use any directories that were stored in the ZIP file. It does this by 
creating the appropriate directory beneath the specified destination directory. Stored directories will 
always display, if present, to the right of the member file list box.



By checking this box WinUnzip will use the directory specified in the Destination Dir edit field as the 
destination or target directory each time the program is run instead of the current directory.    Please 
note that if a destination directory is specified on the command line it will over ride this setting.



The viewer can be any program that will display a file and accept a file name on the command line. 
WinUnzip defaults to NOTEPAD.EXE.    When viewing a file WinUnzip first calls the program 
associated with the file extension of the member file you want to view. If no association exists, then 
WinUnzip will attempt to use the program you designate here as the viewer.

TIP: If you have a file viewer, such as Central Point's File Viewer, that displays files in native format 
we suggest you use that as your default viewer.



This directory is used to temprarily extract files to when using the View or Try It commands.    
WinUnzip uses this directory as a base directory and appends \V$U$E$ to it for safety reasons. It 
then temporarily extracts the file to be viewed to this directory. After the file has been viewed 
WinUnzip deletes the file and the newly created temporary directory. 

The Working directory is useful when viewing member files of a ZIP file that is on a disk that has little
or no free space left. For example, if    you opened a ZIP file on A:, instead of trying to extract    a 
member file to A: where there may be no disk space left, WinUnzip will use the Working directory, for 
example C:\TEMP\V$U$E$, to extract and view the file from. 

WinUnzip will default to the directory you have specified as your Windows TEMP directory the first 
time you run the program. If the directory you specify does not exist WinUnzip will offer to make it for 
you.



association
Data or document files can be associated with the program that created them, or with a program that 
can view them.    This association is easiest made with the Windows File Manager.    More information is 
available in your Windows manual.



current directory
The directory from which WinUnzip was launched.    If you double clicked on a ZIP file in File Manager, 
and you have associated ZIP files with WinUnzip, then the current directory will be that in which the ZIP 
file resides.



member files
The files that are stored within a ZIP file.



short cut keys
Key combinations that issue commands to WinUnzip.    In most cases these key combinations duplicate 
commands issued from the menu or with the mouse.



TEMP
The name of the environment variable that contains the name of your Windows temporary directory.    
You will find this variable in your AUTOEXEC.BAT file.    For example:    TEMP=H:\TEMP



WinUnzip
The original native Windows unzip utility.



ZIP
An archive file containing one or more member files stored using PKZIP or a compatible utility program.






